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SAŽETAK 
 

 

Primjena programa ImageJ u karakterizaciji materijala 

 

U ovom radu dan je teorijski pregled besplatnog programa za analizu slika ImageJ. Zbog 

jednostavnosti korištenja i velikog broja alata, program je našao široku primjenu u mnogim 

znanstvenim disciplinama poput biologije, medicine, kemije, astronomije i sl. 

U eksperimentalnom djelu ovog rada prikazana je praktična analiza programa u karakterizaciji 

materijala. Analizirane su fotografije materijala snimljene skenirajućom elektronskom 

mikroskopijom (SEM) te su određivana svojstva kao što su poroznost, raspodjela veličina 

čestica te udjeli pojedinih faza. Također se pomoću programa pokušalo aproksimirati i 

djelovanje UV/Vis spektrofotometra pomoću fotografije otopina metil oranža različitih 

koncentracija.  

 

Ključne riječi: ImageJ, karakterizacija materijala, SEM fotografije, UV/VIS spektrofotometrija 

 

  



SUMMARY 

 

Application of ImageJ in characterization of materials 

 

This paper provides a theoretical overview of the free image analysis program ImageJ. Due to 

its ease of use and a large number of tools, the program has found a wide application in many 

scientific disciplines such as biology, medicine, chemistry, astronomy, etc.  

In the experimental part of this work, a practical use of the program for characterization of 

materials is presented. Photographs of the materials taken by scanning electron microscopy 

(SEM) were analyzed and properties such as porosity, particle size distribution and 

proportions of individual phases were determined. The program was also used to to 

approximate the operation of the UV/Vis spectrophotometer using photos of methyl orange 

solutions of different concentrations.  

 

Keywords: ImageJ, material characterization, SEM photographs, UV/Vis spectrophotometry  
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1. UVOD  
 

ImageJ je besplatan program za obradu i analizu fotografija koji je prvotno je napravljen za 

analizu slika snimljenih optičkim mikroskopima. Međutim, tijekom vremena su njegove 

mogućnosti i opcije proširene, čime se proširilo i područje njegove primjene. ImageJ je 

program javne domene, što znači da bilo tko može legalno preuzeti i instalirati te proširiti 

djelovanje programa kreiranjem različitih dodataka i alata. Kao rezultat toga, neprestano se 

poboljšava doprinosima korisnika prema njihovoj potrebi. Njegova raznolikost i fleksibilnost 

mu omogućuju da ga znanstvenici koriste kao istraživački alat u mnogim disciplinama, od 

medicine do astronomije [1]. 

U ovom radu će se istražiti primjena programa ImageJ za analizu slika materijala koje su 

dobivene skenirajućim elektronskim mikroskopom (SEM-om) koji projicira i skenira fokusirani 

tok elektrona preko površine kako bi stvorio sliku. Elektroni u snopu stupaju u interakciju s 

uzorkom, proizvodeći različite signale koji se mogu koristiti za dobivanje informacija o izgledu 

površine.  

Također će se ispitati primjenjivost programa ImageJ na procjenu koncentracije otopine metil 

oranža prema boji čime će se pokušati aproksimirati rad UV/VIS spektrofotometra. UV/Vis 

spektrofotometar je instrument pomoću kojeg se može mjeriti količina svjetla iz UV/Vis 

područja koje apsorbira određena vrsta molekule u ispitivanom uzorku. Temelji se na mjerenju 

intenziteta zračenja koje je prošlo kroz analizirani uzorak u usporedbi s intenzitetom zračenja 

prije prolaska kroz uzorak što omogućava određivanje koncentracije te molekule (analita) u 

ispitivanom uzorku.  
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2. OPĆI DIO 
 

2.1. OPĆENITO O PROGRAMU 

ImageJ je program za analizu i obradu digitalnih znanstvenih slika. Program je nastao 1997., a 

razvio ga je Wayne Rasband na Nacionalnim institutima za zdravlje SAD-a (US National 

Institutes of Health). ImageJ se s vremenom unaprjeđivao kako je Rasband nastavio dodavati 

alate prema zahtjevima korisnika te danas postoje mnoge inačice programa kao što su 

ImageJ2, Fiji i drugi [1].  

Od samog početka, ImageJ se pokazao vrlo korisnim u mnogim znanstvenim istraživanjima i 

projektima, a posebice onima iz područja biologije i medicine. Tijekom proteklih dvadeset 

godina njegova upotreba proširila se daleko izvan prvobitno planiranog opsega. Konstantno 

unaprjeđivanje i rekonstruiranje programa omogućilo mu je da ostane lako dostupan i vrlo 

koristan za stručnjake i znanstvenike te relevantan za zahtjeve svoje stalno rastuće zajednice 

[2]. 

U ImageJu mogu se prikazivati, uređivati, analizirati, obrađivati, spremati i ispisivati 8-bitne, 

16-bitne i 32-bitne crno-bijele slike te 8-bitne i 32-bitne slike u boji. Program može čitati 

različite formate slikovnih datoteka kao što su TIFF, PNG, GIF, JPEG, BMP, DICOM, FITS i sl. U 

programu se na temelju određene slike mogu mjeriti površine i vrijednosti piksela kao i 

različite udaljenosti te kutovi. Mogu se napraviti histogrami gustoće i dijagrami. U programu 

je omogućeno uređivanje slika kako bi se uklonili nedostatci, podesila željena svjetlina, 

kontrast, oštrina ili primijenili filtri. Također je moguće nacrtati različite geometrijske oblike 

poput poligona, strjelica itd. unutar slika. Omogućava različite geometrijske transformacije 

kao što su rotacija i zrcaljenje te povećavanje ili smanjivanje fotografije. Program podržava 

neograničeni broj prozora odnosno fotografija istovremeno, ograničen samo dostupnom 

memorijom na računalu. Slovo 'J' u imenu označava programski jezik Java u kojemu je napisan. 

ImageJ je softver javne domene, drugim riječima softver za koji ne postoji apsolutno nikakvo 

vlasništvo poput autorskih prava. Korisnicima je dopušteno pokretati program, dijeliti kopije i 

unositi pozitivne promjene u program. Program je potpuno besplatan te ga je moguće koristiti 

online ili instalirati sa službene stranice. Jedna od najvećih prednosti programa leži u tome što 

su upute za korištenje dostupne na internetskoj stranici bilo kojem korisniku potpuno 
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besplatno. Njegova jednostavnost, slobodan pristup kao i velika ponuda različitih opcija i alata 

ključ su njegova uspjeha [3,4].  

 

2.2. ALATI UNUTAR IMAGEJA 

Nakon pokretanja programa otvara se prozor koji se sastoji od trake izbornika, alatne trake, 

statusne trake te trake za praćenje napretka. Prozor s označenim dijelovima prikazan je na slici 

1. Histogrami, dijagrami, fotografije i slični sadržaji prikazuju se u dodatnim prozorima. 

Rezultati mjerenja otvaraju se u zasebnom prozoru nakon provedene obrade fotografije. 

Prozori se mogu povlačiti po zaslonu i mijenjati veličinu. Histogrami i dijagrami obični su 

slikovni prozori koji se mogu kopirati u međuspremnik, uređivati, ispisivati i spremati. 

 

 

Slika 1. Prikaz prozora ImageJ 

 

Alatna traka sadrži alate za odabir, povećanje i pomicanje slika te za crtanje po slikama i sl. 

Prelaskom miša preko određenog alata prikazuje se opis tog alata na statusnoj traci. Statusna 

traka, kada je kursor iznad slike, prikazuje koordinate i vrijednosti piksela. Na slici 2. prikazana 

je alatna traka s opisom pojedinog alata za obradu fotografija.  Na desnoj strani statusne trake 

nalazi se traka napretka koja prikazuje napredak dugotrajnih operacija. Ako je operacija traje 

manje od jedne sekunde traka se neće prikazati. 
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Slika 2. Prikaz alatne trake s opisom dostupnih alata 

  

ImageJ omogućava istovremeno prikazivanje više slika na ekranu. Onaj prozor koji je u jednom 

trenutku aktivan imat će istaknutu naslovnu traku. Na aktivnom prozoru odvijat će se sve 

primijenjene operacije. Djelovanje ImageJa moguće je proširiti upotrebom takozvanih 

dodataka napisanih u programskom jeziku Java. Dodaci mogu proširiti podršku za nove 

formate datoteka ili mogu dodati nove opcije pri obradi fotografija ovisno o potrebi korisnika. 

Na traci izbornika otvaranjem opcije "plugins" nalaze se dodatci koji su automatski instalirani 

u programu. Više od 150 dodataka dostupno je za dodatno instaliranje na službenoj stranici 

ImageJa [3]. 

 

2.3. PRIMJENA IMAGEJ U ZNANOSTI 

 

ImageJ najveću primjenu pronalazi u biomedicinskim istraživanjima budući da može čitati te 

podržavati većinu najznačajnijih i najčešće korištenih formata biomedicinskih slika. Suvremene 

mikroskopijske tehnike generiraju ogromnu količinu podataka u obliku slika, a ručna analiza 

tih slika daje pristrane rezultate koji se često ne mogu ponoviti. ImageJ pokazao se korisnim 

za izdvajanje numeričkih podataka iz slika, poput površine i veličine stanica ili broja različitih 

stanica. Također se primjenjuje kod kvantitativne analize oblika organela, analize različitih 

tkiva i sl. [5,6]. 
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Program se pokazao korisnim i u istraživanjima iz područja poljoprivrede i botanike gdje se 

koristi kod karakterizacije biljaka. Omogućava mjerenje različitih dijelove biljke poput površine 

listova, npr. određivanje fotosintetskog (tj. zelenog) dijela prošaranog lista, određivanje 

veličina sjemenki kao i razlikovanje zdravih od bolesnih sjemenki. Laboratorijska ispitivanja 

analizom slike jedna su od eksperimentalnih metoda u zaštiti bilja. Koriste se u procjeni 

oštećenja usjeva od raznih nametnika i štetočina, kao i u ispitivanju učinkovitosti različitih 

sredstava korištenih za zaštitu bilja. Upravo u te svrhe napisani su različiti dodatci za ImageJ, 

među kojima je CultivarJ koji je kreiran kako bi se lakše analizirala i identificirala ključna 

svojstva različitih biljnih varijeteta [7,8]. 

Zbog svoje popularnosti u biomedicini i biologiji, ImageJ svoju primjenu proširuje i na druga 

područja i istraživanja kao što su kemija, astronomija, geologija te mnogi drugi. 

U astronomiji, ImageJ se koristi za analizu slika dobivenih od teleskopa i satelita te vizualizaciju 

podataka dobivenih od zvjezdarnica. U te svrhe postoji dodatak AstroImageJ (AIJ), koji pruža 

podršku za nove formate datoteka, prikaz slika specifično za astronomiju te alate za kalibraciju 

slike za astronomiju. Poboljšava obradu astronomskih slika, a vrlo je koristan i kod 

fotometrijskih istraživanja poput određivanja intenziteta elektromagnetskog zračenja 

nebeskih tijela [9]. 

U geološkim istraživanjima primjenu pronalazi u analizi veličine zrna mineralnog pijeska u 

sedimentima, što se obično koristi u sedimentologiji. Olakšava određivanje i mjerenje 

karakteristika oblika mineralnih zrna (tj. promjer, površina, opseg, širina i visina graničnog 

pravokutnika, Feretov promjer, omjer širine i visine, zaobljenost i čvrstoća) iz različitih naslaga. 

Program je pruža objektivnu i učinkovitu analizu granulometrijske strukture čak i kod niskih 

koncentracija pijeska u uzorcima. Metoda je nedestruktivna i omogućuje daljnje analize 

mineralnog sastava i drugih svojstava zrna pijeska [10]. 

 

2.4. SKENIRAJUĆA ELEKTRONSKA MIKROSKOPIJA  

Skenirajuća elektronska mikroskopija radi se na skenirajućem elektronskom mikroskopu 

(SEM), vrsti elektronskog mikroskopa koji proizvodi slike uzorka skeniranjem površine 

fokusiranim snopom elektrona. Mikroskop bilježi informacije o interakciji između elektrona i 

uzorka, stvarajući uvećanu sliku. SEM može povećati sliku i do 2 milijuna puta. Signali koji 
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proizlaze iz interakcija elektrona i atoma uzorka sadrže informacije o uzorku uključujući 

njegovu površinsku teksturu, kemijski sastav i kristalnu strukturu [11].  

Shema rada SEM-a prikazana je na slici 3. Elektronski top služi kao izvor elektrona koji se 

proizvode zagrijavanjem volframske niti ili primjenom jakog električnog polja na posebne 

kristale. Izvori elektrona imaju vrlo oštar vrh tako da se emitira vrlo uzak snop elektrona. 

Anoda zatim ubrzava emitirane elektrone niz kolonu mikroskopa tako što je negativno 

nabijena pa odbija negativno nabijene elektrone tjerajući ih na ubrzavanje. Elektroni se 

fokusiraju na uzorak pomoću magnetskih leća koje osiguravaju da vrlo uzak snop elektrona 

pogodi uzorak, prilikom čega dolazi do interakcija snopa s uzorkom. Dio elektrona se elastično 

povratno rasprši u smjeru ulaznog snopa, a dio elektrona prodire u uzorak pobuđujući emisiju 

tzv. sekundarnih elektrona. Količina povratno raspršenih i sekundarnih elektrona ovisi o 

mnogim čimbenicima kao što su hrapavost površine, kemijski sastav i kristalna struktura 

uzorka. Udarom elektrona u atome uzorka također nastaju rendgenske zrake karakteristične 

za pojedine vrste atoma, čijom se analizom otkriva koji elementi postoje u uzorku. Postoji 

mnogo različitih vrsta detektora koji mogu detektirati elektrone različitih energija koji putuju 

u različitim smjerovima, a ovisno o tome koji detektor se koristi mogu se dobiti različite 

informacije o uzorku [12]. 

 

Slika 3. Shema skenirajućeg elektronskog mikroskopa 
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2.5. UV/VIS SPEKTROSKOPIJA [13] 

Spektroskopija u ultraljubičastom i vidljivom području (UV/Vis) analitička je tehnika koja mjeri 

količinu ultraljubičaste i vidljive svjetlosti koju apsorbira ili propušta uzorak u usporedbi s 

referentnim uzorkom, a do apsorpcije dolazi uslijed elektronskih prijelaza u molekulama. Na 

apsorbanciju utječe sastav uzorka, potencijalno pružajući informacije o tome što je u uzorku i 

u kojoj koncentraciji. UV/Vis spektroskopija široko je korištena tehnika u mnogim područjima 

znanosti od uzgoja bakterija, identifikacije lijekova i provjere čistoće nukleinskih kiselina, do 

kontrole kvalitete u industriji pića i kemijskih istraživanja.  

Instrument koji se koristi u UV/Vis spektroskopiji naziva se UV/Vis spektrofotometar. Mjeri 

intenzitet svjetlosti nakon prolaska kroz uzorak (I) i uspoređuje ga s intenzitetom svjetlosti 

prije prolaska kroz uzorak (I0). Logaritam omjera I/I0 naziva se apsorbancija, koja se 

matematički može opisati Beer-Lambertovim zakonom: 

A = ε*b*c    (1) 

 gdje je ε  molarni apsorpcijski koeficijent (L mol-1 cm-1), b duljina puta svjetlosti kroz uzorak 

(cm), a c je koncentracija uzorka (mol L-1). 

 Na slici 4. prikazani su osnovni dijelovi UV/Vis spektrofotometra. Sastoji se od izvora svjetlosti, 

disperznog elementa (monokromator), kivete za otopinu uzorka, fotoelektričnog detektora i 

procesora signala te uređaja za njegovo čitanje.  

 

Slika 4. Shema UV/VIS spektrofotometra 
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Informacije UV-Vis spektroskopije se najčešće prikazuju kao graf apsorbancije u ovisnosti o 

valnoj duljini koje se naziva apsorpcijski spektar. Iz snimljenog se spektra može odrediti pri 

kojoj valnoj duljini određena molekula najbolje apsorbira, a pomoću Beer-Lambertovog 

zakona odrediti koncentracija otopine iz izmjerene apsorbancije. 

Glavne prednosti UV/Vis spektroskopije su brzina mjerenja, instrumenti koji su jednostavni za 

korištenje te ne zahtijevaju opširnu obuku korisnika prije uporabe. Također, obrada podataka 

analize je jednostavna, a instrumenti nisu skupi što ih čini dostupnima mnogim laboratorijima.  
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3. EKSPERIMENTALNI DIO 

 

3.1. POSTAVLJANJE SKALE 

Postavljanje skale je prvi korak u obradi i analizi SEM mikrografije. Za podešavanje skale u 

izborniku je potrebno odabrati ravnu (straight) liniju pomoću koje se zatim označi duljina 

originalne SEM skale kao što je prikazano na slici 5. Zatim se odabirom opcije Analyze > Set 

Scale otvara prozor koji je prikazan na slici 6. U polje Known distance upiše se broj sa skale, a 

pod Unit of lenght odgovarajuća mjerna jedinica. Nakon toga skala je postavljena i može se 

nastaviti s daljnjom analizom. 

 

 

Slika 5. Podešavanje skale sa SEM fotografije 

 

 

 

Slika 6. Prozor za postavljanje skale 
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3.2. ODREĐIVANJE POROZNOSTI 

Nakon podešavanja skale u izborniku se odabere pravokutno izrezivanje (Rectangle) koji služi 

za izrezivanje dijela fotografije u kojem se planira odrediti poroznost. Nakon označavanja 

željenog dijela, desnim klikom odabire se opcija Duplicate nakon čega se pojavljuje dodatna 

slika na kojoj će se određivati poroznost, bez da se učinjene izmjene ili postupci analize 

primjenjuju na prvobitnu sliku. Primjer jedne od SEM mikrografija uzorka na kojemu se 

određivala poroznost prikazana je na slici 7.  

 

 

Slika 7. SEM mikrografija uzorka ZrO2 

 

Kod određivanja poroznosti uzorka za početak se treba postaviti prag (engl. treshold), tako da 

se u izborniku odabere Image > Adjust > Treshold (može se napraviti i istovremenim pritiskom 

tipki Shit+Ctrl+T), čime se otvori dodatni prozor koji služi za podešavanje praga. Prag se podesi 

na način da uzorak bude obojen, a pore ostanu crne. Zatim se otvara dodatna slika prikazana 

na slici 8. gdje su pore obojane crno , a uzorak bijelo.  
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Slika 8. Fotografija uzorka ZrO2 nakon primjene Tresholda 

 

Nakon toga se u izborniku odabere opcija Analyze > Analyze particles čime se otvara prozor 

prikazan na slici 9. Primjenom namještenih parametara dobiju se tablični rezultati prikazani na 

slici 10. gdje se poroznost nalazi pod kolonom 'Area' i grafički rezultati gdje su pore izolirane i 

numerirane kao što je prikazano na slici 11.  

 

 

Slika 9. Prozor Analyze particles 
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Slika 10. Prikaz tablice rezultata poroznosti 

 

 

Slika 11. Fotografija s izoliranim porama 

 

U slučaju da Treshold nije savršeno izolirao sve osim pora, minimalna površina se može staviti 

0.02-Infinity kako program ne bi uključio sitne točkice. Potrebno je podesiti i Show: Outlines 

kako bi se iscrtale detektirane pore. Parametar Circularity se zada od 0-1.0 kako bi se 

analizirale i sferne i cilindrične te sve nepravilne pore. Za izoliranje savršenih krugova, 

potrebno je zadati Circularitiy od 0.8 do 1.0.  

Poroznosti navedenih materijala određene su i eksperimentalno Arhimedovom metodom koja 

se temelji na određivanju gustoće vaganjem uzorka u zraku te u vodi. Tada se poroznost 

računa prema slijedećoj formuli: 

Poroznost= 1 – 𝜌eksp/ 𝜌teor   (2) 
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Gdje je: 

𝜌 =  
𝑚𝑧(𝜌𝑣−𝜌𝑧 )

𝑚𝑧−𝑚𝑣
+ 𝜌

𝑧
    (3) 

 

mz – masa uzorka vagana u zraku 

mv – masa uzorka vagana u vodi 

Gustoća zraka: 𝜌𝑧  = 0,0012 gcm-3 

𝜌𝑣 - gustoća vode  

 

3.3. ODREĐIVANJE UDJELA SVIJETLE I TAMNE FAZE 

Nakon podešavanja skale izreže se dio fotografije gdje nema pora kako bi se mogao odrediti 

udio svijetle i tamne faze. Primjer takve fotografije prikazan je na slici 12. Ako je potrebno, 

radi lakšeg određivanja moguće je podesiti svjetlinu ili bolji kontrast između svijetle i tamne 

faze.   

 

 

Slika 12. Primjer fotografije za određivanje udjela faza 

 

Nakon toga postavi se prag kako je prethodno opisano, tako da se izoliraju samo tamna 

područja kao što je prikazano na slici 13. gdje je tamna faza obojena crno, a svijetla faza bijelo. 
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Slika 13. Prikaz izolirane tamne faze 

 

Pomoću opcije Analyze > Analyze particles dobiju se tablični i grafički rezultati na kojima je 

izolirana tamna faza prikazani na slici 14. U dobivenoj se tablici  pod kolonom Area nalazi 

udio tamne faze, pomoću koje se zatim izračuna udio svijetle faze. 

 

 

Slika 14. Prikaz izolirane tamne faze 

 

3.4. ODREĐIVANJE RASPODJELE VELIČINE ČESTICA I PROMJERA VLAKANA 

Promjer čestica ili vlakana određuje se ručno pomoću ravne linije (Straight). Primjer SEM 

mikrografije uzorka koji je služio za određivanje promjera vlakana dan je na slici 15., a primjer 

SEM mikrografije uzorka za određivanje promjera čestica dan je na slici 16.  
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Nakon što se ravnom linijom odredi promjer, pritiskom tipki ctrl+M otvara se prozor u kojem 

se pod kolonom Lenght nalaze rezultati. Prije početka analize potrebno je otići u Analyze > Set 

measurements i uključiti opciju Display label kako bi program mogao numerirati vlakna 

odnosno čestice nakon što ih se ručno odredi. Nakon mjerenja podatci se kopiraju u Excel koji 

se koristi za crtanje histograma. 

 

 

Slika 15. Primjer SEM mikrografije korištene za određivanje promjera vlakana 

 

 

Slika 16. Primjer SEM mikrografije korištene za određivanje promjera čestica 
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3.5. ODREĐIVANJE APSORBANCIJE 

Pripremljena je početna otopina metiloranža (MO) otapanjem 20 mg MO (C14H14N3NaO3S p.a., 

Kemika) u 1 L destilirane vode. Iz te otopine je zatim pripremljeno pet otopina sljedećih 

koncentracija: 4 mg/L, 8 mg/L, 12 mg/L, 14 mg/L te 16 mg/L. Za navedene je otopine pomoću 

UV/VIS LLG unispec 2 spektrofotometra snimljena ovisnost apsorbancije o koncentraciji.  

Po 4 mL svake pripremljene otopine ispipetirano je u prozirni plastični nosač s pregradama te 

je snimljena fotografija za analiziranje u ImageJ-u prikazana na slici 17. Obradom fotografije 

određen je intenzitet komplementarnih boja, u ovom slučaju zelene i plave, za pojedinu 

otopinu. Nakon pokretanja programa, na izborniku se pomoću opcije pravokutnog izrezivanja 

(Rectangle) na fotografiji označi određena boja odnosno pojedina otopina određene 

koncentracije te se na izborniku odabere opcija Plugins > Analyze > RGB Measure. Zatim se za 

pojedinu otopinu dobije koliko ima crvene, zelene i plave boje. S dobivenim se podatcima u 

excelu crta baždarni pravac gdje se na ordinati nalazi logaritam kvocijenta I/I0 , a na apscisi 

koncentracije pripremljenih otopina. Prva nijansa odnosno destilirana voda predstavlja I0 dok 

sve druge nijanse odnosno pripremljene otopine imaju intenzitet I.  

 

 

Slika 17. Ispitivane otopine metil oranža 
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4. REZULTATI I RASPRAVA 
 

4.1. POROZNOST 

Na slici 18. su uspoređene SEM mikrografije triju uzoraka na kojima je određivana poroznost 

(u gornjem redu) te pripadajuće fotografije koje prikazuju izolirane pore pomoću ImageJ-a (u 

donjem redu). 

 

 

Slika 18. Prikaz SEM mikrografija (gornji red) i pripadajuće fotografije s izoliranim porama (donji red) 

 

Tablica 1. Rezultati određivanja poroznosti 

 Poroznost određena 

Arhimedovom metodom 

Poroznost određena 

analizom u imageJu 

ZrO2  28 % 22 % 

20% Al2O3 15 % 10 % 

30% Al2O3 18 % 11 % 

 

U tablici 1. prikazani su rezultati poroznosti koji su izmjereni eksperimentalno Arhimedovom 

metodom te poroznosti određene pomoću analize fotografija u ImageJu za tri uzorka ZrO2, 
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20 % Al2O3 te 30 % Al2O3. Za sva tri uzorka poroznost određena pomoću analize fotografija je 

manja u odnosu na eksperimentalno određenu poroznost.  

Do odstupanja poroznosti koje su određene analizom SEM mikrografije u odnosu na poroznost 

određene eksperimentalno dolazi stoga što se pri analizi fotografije određuje površinska 

poroznost, odnosno zbog dvodimenzionalnosti fotografije, dok su poroznosti određene 

Arhimedovom metodom trodimenzionalne. No trend ostaje sačuvan, tj. poroznost uzoraka 

raste redoslijedom 20 % Al2O3 < 30 % Al2O3 < ZrO2 bez obzira na metodu određivanja. To čini 

ImageJ jednostavnom metodom za preliminarno određivanje poroznosti materijala. 

 

4.2. UDIO SVIJETLE I TAMNE FAZE 

Udio svijetle i tamne faze određivan je za uzorke 20% Al2O3 te 30% Al2O3. U tim uzorcima 

svijetla faza je ZrO2 (koji se sastoji od težih atoma), a tamna Al2O3. Na slici 19. prikazan je 

izrezani dio bez pora koji se koristio za analizu te su u donjem redu prikazane fotografije 

dobivene u ImageJu koje prikazuju izoliranu tamnu fazu.  

 

Slika 19. Usporedba SEM mikrografija (gornji red) s pripadajućim fotografijama s izoliranom tamnom fazom 
(donji red) 
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U tablici 2. su prikazani udjeli svijetle i tamne faze za 20 % Al2O3 te 30 % Al2O3 dobiveni 

obradom SEM mikrografije, uspoređeni s teorijskim volumnim udjelom ZrO2 u uzorcima, 

izračunatima preko gustoća čistih ZrO2 i Al2O3. 

 

Tablica 2. Rezultati određivanja udjela svijetle te tamne faze 

 20 % Al2O3 30 % Al2O3 

Udio svijetle faze (ZrO2) 60,97 % 54,77 % 

Udio tamne faze (Al2O3) 39,03 % 45,23 % 

Teorijski volumni udio ZrO2 72,71 % 60,08 % 

 

Udjeli svijetlih faza izračunatih pomoću programa manji su od teorijskih volumnih udjela 

svjetle faze odnosno ZrO2, no uspješno je određeno to da je udio svijetle faze veći od udjela 

tamne. 

 

4.3. RASPODJELA VELIČINA VLAKANA I ČESTICA 

Na slici 20. prikazan je histogram raspodjele promjera vlakana uzorka. Vidljivo je kako najviše 

vlakana, točnije 29, ima promjer u rasponu od 0,746 μm do 0,896 μm, dok svega dva vlakna 

imaju promjer u rasponu od 1,496 μm do 1,646 μm. Histogram je bimodalan, tj. s dva 

maksimuma, što je vjerojatno posljedica nereprezentativnog uzorka (tj. korištenja samo jedne 

fotografije). Za pouzdanije određivanje trebalo bi analizirati nekoliko fotografija snimljenih na 

različitim dijelovima uzorka. 
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Slika 20. Histogram raspodjele veličine vlakana 

 

Na slici 21. je prikazan histogram raspodjele veličine čestica u uzorku. Najviše čestica, odnosno 

njih 71 se nalazi u rasponu promjera od 0,501 μm do 0,751 μm, a samo četiri čestice imaju 

promjer veći od 2 μm. 

 

 

Slika 21. Histogram raspodjele veličine čestica 

 



21 
 

4.4. APSORBANCIJA 

U tablici 3. su prikazane koncentracije pripremljenih otopina metil oranža te pripadajuće 

apsorbancije snimljene spektrofotometrom. Pomoću navedenih podataka nacrtan je baždarni 

dijagram prikazan na slici 22. 

 

Tablica 3. Izmjerena apsorbancija otopina metil oranža 

 
γ  
(mg/L) 0 4 8 12 14 16 20 

 
A 0 0,305 0,611 0,945 1,116 1,241 1,585 

        
 

 

 

Slika 22. Baždarni dijagram dobiven mjerenjem spektrofotometrom 

 

 

Rezultat dobiveni obradom slike prikazani su u tablici 4. gdje je prikazano koliko se koje boje 

(plave, zelene, crvene) nalazi u fotografiji destilirane vode (0 mg/L) te fotografijama pojedinih 

otopina metiloranža (4-20 mg/L). 
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Tablica 4. Podatci dobiveni obradom fotografije alikvota metil oranža 

 
γ  (mg/L) 0 4 8 12 14 16 20 

Crvena 184 202 202 195 188 186 182 

Zelena 183 162 141 120 111 107 97 

Plava 179 48 24 29 31 30 33 
 

 

Na slici 23. prikazan je baždarni pravac dobiven mjerenjem intenziteta zelene boje. Iz 

vrijednosti R2 = 0,9977 može se zaključiti kako je linearnost potvrđena u području 

koncentracija 0 mg/L do 20 mg/L, dok za grafove koji se odnose na plavu boju (slika 24.) i 

kombinaciju plave i zelene (slika 25.) linearnost nije potvrđena. Stoga se analiza fotografija 

ImageJ-om može iskoristiti kao priručni spektrofotometar, ali uz prethodnu obaveznu provjeru 

linearnosti za odabranu boju. 

 

 

Slika 23. Baždarni dijagram dobiven obradom slike za zelenu boju 
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Slika 24. Baždarni dijagram dobiven obradom slike za plavu boju 

 

 

 

Slika 25. Baždarni dijagram dobiven obradom slike za kombinaciju zelene i plave boje 
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5. ZAKLJUČAK 
 

ImageJ obiluje raznolikim alatima za obradu fotografija u različite svrhe. Cilj ovog rada bio je 

obradom SEM mikrografija materijala odrediti poroznost, raspodjelu veličina vlakana i čestica 

te udjele faza koje se na SEM mikrografijama razlikuju kao svijetli i tamni dijelovi slike.  

Poroznosti dobivene obradom fotografije za ZrO2 iznose 22 %, za 20 % Al2O3 10 %, a za 30 % 

Al2O3 11 %. Eksperimentalno dobivene poroznosti za navedene materijale redom iznose 28 %, 

15 % i 18 %. Do razlike dolazi jer je poroznost dobivena obradom fotografije dvodimenzionalna 

dok je eksperimentalno određena trodimenzionalna poroznost, ali trend ostaje sačuvan. 

Dobiveni udjeli tamne faze za 20 % Al2O3 iznosi 39,03 %, a za 30 % Al2O3 iznosi 45,23 %, 

odnosno udjeli svijetle faze iznose 60,97 % te 54,77 %. Teorijski volumni udjeli ZrO2 odnosno 

svijetle faze iznose za 20 % Al2O3 72,21 % te za 30 % Al2O3 60,08 %. Usprkos znatnom 

odstupanju, pomoću ImageJa uspješno je identificirana faza većeg volumnog udjela. 

Dobiveni histogrami raspodjele veličine čestica odnosno promjera vlakana daju korisne 

informacije o uzorcima, iako bi za veću pouzdanost trebalo analizirati više fotografija za isti 

uzorak. 

Aproksimirano je djelovanje UV/Vis spektrofotometra pomoću fotografije otopina metil 

oranža koncentracija 4 mg/L, 8 mg/L, 12 mg/L, 14 mg/L, 16 mg/L te 20 mg/L. Usporedbom 

baždarnog dijagrama dobivenog UV-Vis spektrofotometrom s baždarnim dijagramima 

dobiveni obradom fotografije uočava se kako je linearnost u navedenom koncentracijskom 

području potvrđena za zelenu boju. Za plavu boju kao i kombinaciju plave i zelene linearnost 

nije potvrđena, pa treba paziti da se uvijek odabere odgovarajuće linearno područje kod 

korištenja analize slike kao priručnog spektrofotometra. 

U cjelini, ImageJ nalazi primjenu i u analizi materijala i daje korisne informacije o uzorku na 

temelju (najčešće) SEM fotografija. 
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